
 

 
Pendants + Rings Marking Machine 

BB-S7 
 

 

User manual 
 

◆ Read and understand the User Manual before using the machine. 

◆ Failure to follow the operating instructions may result to injury and/or machine damage. 

 

Take note: The product images shown are for illustration purposes only. Actual appearance and technical 

specifications of the machine may vary due to product enhancement. 

 

 

 

 

<Please wear safety goggles and safety mask to avoid eye injury from metal chips and 

dusts and to prevent exposure from inhalable harmful elements and particles.> 
*Debris produced during engraving process like metal chips and dusts may cause eye injury if they get 

stuck in your eye or may cause respiratory problems if inhaled. 

 

 

 

 

 

 

 

 

This manual has been drawn up by BBJE. 
All rights reserved.   

No part of this publication may be reproduced or used in any form 
 or by any means without the permission of BBJE. 

Edition:  Oct, 2021 
 

Best Built Jewelry Equipment 
42 Andrews Road 

Hicksville, NY 11801 
516- 868-6045 

www.jdsincbb.com 

  

http://www.jdsincbb.com/


1 

Contents 
Precautions for use............................................................................................................. 2 

Model ...................................................................................................................................... 4 

BB-S7 ...................................................................................................................................... 5 

1. Package Contents ........................................................................................................... 5 
2. Specifications .................................................................................................................. 7 
3. Description ...................................................................................................................... 8 

(1) Machine .................................................................................................................... 8 
(2) Clamp...................................................................................................................... 10 
(3) Keypad .................................................................................................................... 25 
(4) Menu ....................................................................................................................... 26 
(5) Display .................................................................................................................... 27 
(6) Status indicator ....................................................................................................... 31 
(7) Switching Tools ....................................................................................................... 32 

4. Installation ..................................................................................................................... 33 
(1) Machine Installation ................................................................................................ 33 
(2) Program Installation ................................................................................................ 35 
(3) Front Cover ............................................................................................................. 37 
(4) IO Port..................................................................................................................... 39 
(5) Back Cover ............................................................................................................. 40 

5. Operation of the Marking Machine ................................................................................ 41 
(1) Self-diagnose Procedures ...................................................................................... 41 
(2) Marking Procedures ................................................................................................ 41 

Before Using the Program .............................................................................................. 43 

Program Usage Description ........................................................................................... 44 

1. Toolbar ........................................................................................................................... 46 
2. Text Object Property ...................................................................................................... 62 
3. Rotation Tool Property ................................................................................................... 67 
4. How to Engrave for Each Toolpath ................................................................................ 68 
5. Create Toolpath ............................................................................................................. 71 

(1) Tool: Add/Delete/Edit .............................................................................................. 74 
(2) Engraving Option: Add/Delete/Edit ......................................................................... 75 

6. Toolpath Object Property ............................................................................................... 76 
7. NC Data Output ............................................................................................................. 78 

(1) Transfer the Toolpath Data after Creating a Toolpath ............................................. 78 
(2) Transfer the Toolpath Data after Entering Text ....................................................... 80 
(3) Camera ................................................................................................................... 81 

8. Auto Focus .................................................................................................................... 83 

Marking Process ................................................................................................................ 84 

Ring Inner/Outer Marking Process ............................................................................... 89 

Photo Marking .................................................................................................................... 94 

Pen Engraving Process ................................................................................................... 98 

Engraving Curved Materials ......................................................................................... 102 

Layout of Text in a Circle ............................................................................................... 103 

Layout of Text in a Curve .............................................................................................. 105 

Text Change ...................................................................................................................... 106 

Template Creation ........................................................................................................... 107 

Saving as Design Sample .............................................................................................. 111 

Auto Change of Serial Number .................................................................................... 114 

Loading and Editing Image ........................................................................................... 116 

1. Loading an image ........................................................................................................ 116 
2. Converting and editing image ..................................................................................... 117 

Import a File in SVG format .......................................................................................... 119 

Calibration ......................................................................................................................... 121 

1. Touch Sensor (Tool Calibration) .................................................................................. 121 
2. Laser Pointer Calibration ............................................................................................. 121 
3. Saving Multi-performance Clamp Origin Position ....................................................... 124 
4. Saving New Clamp Origin Position ............................................................................. 125 
5. Chuck Finger Origin point............................................................................................ 125 
6. Rotation Clamp Origin point (Z axis) ........................................................................... 127 
7. Camera calibration ...................................................................................................... 128 

  



2 

Precautions for use 
Read and follow the instructions carefully for safe use of the machine. Failure to follow 

safety precautions may result to injury and/or machine damage. 
 

Intended use: BB-S7 is intended for engraving 
 

● Please follow the necessary safety precautions to prevent injury and/or machine damage. 
● Please read carefully and understand the instructions below for proper and safe use of the machine. 

 
Failure to follow these instructions may result to machine damage. 

 
Failure to follow these instructions may result to physical injury or harm. 

 

 Safety Precautions on Electrical System 

 

Do not use a damaged power cord or a 
loose electrical outlet. This may cause 
electric shock or fire.  

Do not plug in two or more devices in a 
single outlet simultaneously. Overloading 
your plug sockets may lead to overheating 
which may cause fire. 

 

Do not pull a plug by the cord. 
Do not grab a plug with wet hands. This 
may cause electric shock and burns.  

Pull out the power plug when the machine is 
not in use. 

 

If smoke comes out of the machine, switch 
off the machine immediately. Do not 
attempt to repair and/or disassemble the 
machine, contact our technical support for 
immediate diagnosis and repair. 

 

Plug the machine into a grounded outlet 
only. The machine may fail if plugged into an 
ungrounded outlet, causing property 
damage, physical injuries, electric shock or 
fire. 

 Safety Precautions on Machine Operation 

 

Use the machine properly and strictly 
follow the safety precautions. We will not 
be held responsible for any damages or 
injuries caused by mishandling or misuse 
of the machine. 

 

Avoid using materials that may get caught or 
jammed in the machine. The engraving and 
cutting performance and quality of the 
machine may vary depending on the 
materials used.  

 

Be sure to use goggles to prevent eye 
injury from metal chips and dusts. Use a 
safety mask to prevent exposure from 
inhalable elements and particles. 

 

Protect your fingers, hands and wrists 
during operation. The engraving cutter of the 
machine is sharp and may cause cuts 
and/or serious injuries if get caught in 
between the axis.  

 

Be sure to use a Chip collector to 
remove the particles produced during 
engraving process. Debris like metal 
chips and dusts may cause serious eye 
injury if they get stuck in the eye, and may 
cause respiratory problems if inhaled. 

 

Do not put any foreign objects or any fire 
hazards on the machine. Never put the 
machine near or above any heating devices 
or any flammable materials. 

 

Be sure to place the machine on a firm, flat 
and level surface. If the machine is not 
properly installed or placed, the machine 
may fall, causing physical injury, electric 
shock or fire. 

 

Be sure to keep the machine out of 
children’s reach and sight. Children’s 
curiosity may lead to injury. 

 

Do not disassemble, assemble or modify 
the machine. This can lead to machine 
failure and damage, causing fire or electric 
shock. Please contact our technical 
support for proper diagnosis and 
inspection, calibration, and repair. 

 

Avoid spilling water or any liquids on the 
machine. This may result to machine failure 
and damage, causing electric shock or fire. 
If any liquids or foreign objects gets inside 
the machine, the machine may vibrate 
excessively then fall. This may cause injury. 
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 Safety Precautions on Machine Operation 

 

Protect your hands, wrists and fingers. 
Do not let any of your body parts or any 
foreign objects get caught in the 
machine during operation. The tools of 
the machine are sharp, and may cause 
serious physical injury. 

 

 

Please wear safety glasses during 
engraving process for safety. Debris like 
metal chips and dusts may cause serious 
eye injury if they get stuck in the eye. 

 

 

Do not put any foreign objects or any tiny 
metals inside the machine. This may result 
to machine failure and damage, causing 
fire or electric shock.  

 

If there is smoke, moisture, oil, dust or 
water in the place where the machine is 
installed, do not use the machine. This 

may cause electric shock or fire. 

 

Do not attempt to disassemble and clean 
the machine if the machine suddenly 
generates some type of lubricant oil. 
Contact our technical support immediately. 

  

 Other Precautions 

 

Do not disassemble or modify the 
machine. This can cause machine failure 
and damage.  

Be sure that the machine is placed and 
kept in a room temperature. If the 
temperature drops below freezing, the 
machine may not work property.  

 

In order to prepare for an emergency, in 
case of a sudden machine malfunction or 
failure, users are strictly advised to not 
leave the machine unattended while in 
operation. Users should refrain from 
engaging in any activity that diverts 
his/her attention while actually engaged 
in operating the machine. 

 

<PROPER MACHINE DISPOSAL> 
The machine contains valuable raw materials and electronic components which must be 
properly disposed of in equipment disposal containers.  
 
According to European guidelines on proper equipment disposal:  
●Do not dispose of together with household waste. 
●Used electric and electronic equipment must be collected separately and not be placed in 
municipal waste. 

 
 

Laser Specifications  
 

The machine utilizes red laser ‘CLASS 2’ as a guide laser. 
 
- CLASS 2: Class 2 laser is a relatively weak laser that is considered safe for normal operation Its visible beam 

does not cause any harm or damage on a person’s eye unless deliberately stared into it. It is not a 
skin or materials burn hazard as well.  

 

Class Class 2 

Output <1mW 

Wavelength 650nm 
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Model 
 

Model BB-S4 BB-E4 BB-S7 BB-E7 

Engraving 
area 

213*161 216*158 112*100 112*100 

Rotary 
Clamp ✖ ✖ ● ● 

Spindle ✖ ● ✖ ● 

DC Motor - 38w - 38w 

Spindle 
RPM 

- 15,000 - 15,000 

Probe 
Sensor ✖ ● ✖ ● 

※ This table shows the differences between models. Please check BB-E7. 
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BB-S7 
1. Package Contents  
BB-S7 provides the following tools and devices. The contents of the package may vary if optional items are 

purchased. 

 

Take note: 

*Cutter, tip and spindle belts easily wear out. Make sure to replace them regularly or as per maintenance 

schedule. 

*All pictures shown are for illustration purpose only. Images may differ from the actual products. 

*Be sure to use a safety mask and safety glasses to avoid injury during machine operation.  
 

Name Picture Quantity Usage 

BB-S7 

 

1EA 

Marking machine 

※Be sure to use a safety mask and 

safety goggles during machine operation 

for safety. 

Power adapter 
(CP-01&CP-02) 

 

1EA 

Power supply 

※Use a grounded outlet only. Do not 

plug the machine into an ungrounded 

outlet. 

USB cable 
(CP-11) 

 

1EA For connecting to PC 

USB  1EA 

To install MagicEngrave software  

※See program installation for further 

details. 

User manual 
 

1EA Operating manual 

T-wrench(2.5mm) 
(CP-T25) 

 

1EA For tightening/unscrewing the bolt. 

L-wrench(1.5mm) 
(CP-L15)  1EA For tightening/unscrewing the bolt. 

Ruler 
(CP-24)  1EA For measuring the material. 

Tool fixing bolt 
(M5x6)  3EA To fasten the spindle tool. 

L-tool fixing bolt 

(M3x4)  3EA To fasten the L-tool tip. 

Diamond tip(4Ø ) 
(T40-DA22)  1EA For spindle: Tool used for engraving 

Diamond tip(3Ø ) 
(T31-DA09)  1EA 

For L-tool: Tool used for engraving the 

inside of a ring. 

Bakelite plate 

(120x100x2t) 
 

1EA For calibrating the camera. 
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Multi-performance Clamp 

(CP-250) 

 

1EA 
To hold materials with different shapes 

in place. 

Pin 

(CP-172)  6EA 
To hold materials with irregular shapes 

in place. 

Height adjustable clamp 

(CP-252) 

 

1EA To adjust the height of the clamp. 

Finger chuck handle 

(CP-31)  2EA To fasten the rotary clamp. 

Flat finger chuck 

(CP-38)  
3EA 

For holding rings in place when 

engraving the inside or outside.  

Round finger chuck 

(wide width) 

(CP-39) 
 

3EA 
For holding rings in place when 

engraving the inside or outside. 

Finger skin 

(CP-41)  
1SET For protecting finger chuck. 

Finger chuck spanner 

(CP-21)  
1EA 

For tightening/unscrewing the finger 

chuck. 

 

*Optional (Sold separately) 

Back Cover 
(CP-253BB)  

1SET Back Port Cover 

Front cover 

 

1SET 
To prevent inhaling of dusts and 
scattering of chips produced during 
engraving process. 

Spacer block 
(CP-250S) 

 

1SET To adjust the height of the clamp. 

Tailstock 
(CP-251) 

 

1SET To hold pens in place.  

Pin clamp 
(CP-80) 

 

1SET 
To hold materials with different shapes 
in place. 

Cutlery clamp 
(CP-83) 

 

1SET To firmly hold spoons in place. 

Watch adapter 
(CP-84) 

 

1SET To firmly hold watch in place. 
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Bracelet adapter 
(CP-85) 

 

1SET To firmly hold bracelets in place. 

Bar necklace adapter 
(CP-166) 

 

1SET 

Jig for holding materials with narrow 
width (about 2-3mm) in place. 
(Used for securing pendants, bar 
necklaces, etc.)  

Curved tag adapter 
(CP-182) 

 

1SET 

Jig for holding curved materials in 
place. 
(Used for securing curved pendants, 
chain bracelets, etc.)  

Round chuck finger 
(Narrow width) 

 
3EA 

For holding rings in place when 
engraving on the inside. 

 
 

2. Specifications 
 

 

Operating voltage AC 100~240V 

Power consumption 25W 

Frequency 50/60Hz 

Dimensions 
402.5 mm(W) x 376.5 mm(D) x 352.5 mm(H)  

15.8 in(W) x 14.8 in(D) x 13.9 in(H) 

Max. engraving area 
140mm(X) x 100mm(Y) x 38.5mm(Z) 

5.51 in(X) x 3.93 in(Y) x 1.51 in(Z) 

Maximum material height 60mm/ 2.4 in 

Rotary operating range 

(Based on 2mm/ 0.08in) 

Cylinder outside diameter: MAX. 92mm (X) / MAX. 3.62 in (X) 

Cylinder inside diameter: MAX. 14mm (X) / MAX. 0.55 in (X) 

Weight 26kg / 57.32lb 

Bluetooth Bluetooth LE module/ Bluetooth 5.0 

Transfer speed 80mm/sec (X,Y), 18mm/sec (Z) 

Temperature 15 – 40°C 

Humidity 10 - 90% 

Purposes 
Metal marking, Pen marking, Ring marking (inside), Ring marking 

(outside), etc. 
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3. Description 
(1) Machine 

 
 

 

 
                           

             

 

 

 

 

 
 
  

Protect your hands, wrists and fingers. Do not put any of your body  

parts inside the machine or anywhere near the head during operation. 

G. Control panel 

I. Emergency switch 

H. Status indicator 

J. Power switch 

E. Spindle 

D. L-tool fixing Bolt 

K. USB port 

L. Power port 

M. IO port 

F. Tool length sensor 

C. L-tool 

A. Camera 
B. Pressure Adjuster 
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A Camera Shows actual view of material to design. 

B Pressure Adjuster Adjusts the pressure of the engraving tool. 

C L-Tool 

Secures the L-tool tip when engraving on the inside of rings or 

bangles. 

※To change tools, use a 1.5mm L-wrench. 

D L-Tool Fixing Bolt Secures the L-tool. 

E Spindle 
Secures the tool for engraving.  

※To change tools, use a 2mm T-wrench. 

F Tool length sensor Automatic tool length measurement sensor. 

G Control Panel 
Controls the power button and the manual control for regulating 

engraving operations. 

H Status Indicator Shows the status of the device via blinking interval 

I Emergency Switch Stops the machine during emergency. 

J Power Switch Switches the power on/off. 

K USB Port To connect USB cable to PC. 

L Power Port 

To connect power adapter to supply power to the machine. 

※Use a grounded outlet only. Do not plug the machine into 

an ungrounded outlet. 

M IO Port To connect the dust connector. 
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(2) Clamp 
1) Multipurpose Clamp 
The package includes a multifunctional clamp that is easily assembled, disassembled and transformed into 3 
different types of clamps. It can be adjusted according to the height of the material, and can be expanded 
according to the material’s thickness, size, and shape. This single clamp alone makes engraving on various 
materials possible without the use of any additional clamps. 
 

 
 
 
 

[How to secure the material in place] 
Use the clamping knob to secure your material in place. To loosen or widen the clamp, turn the clamping knob 
counterclockwise; to fasten it, turn the knob clockwise. 
 
 

          
 

Marks may be left on the material if fastened tightly.  
 
 

 
[How to position the material] 
Use the vertical ruler bar as an alignment guide to help you position and align your material to the clamp with 
ease and accuracy. Properly place your material on the clamp then check the alignment. 

 
 
  

Clamp fastening knob 

Clamp slider 

Clamp base 

Pin holes 

M4 tap 
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[How to secure the material with irregular shape in place] 
Use the clamping pins to firmly hold materials with irregular shapes in place. To secure the clamping pins to the 
clamp, simply insert the pins into the pin holes then fasten them. 

 
 
[How to adjust the height of the clamp] 
Below are instructions on how to adjust the height of the clamp according to the thickness of the material. 
 

                             
< Clamp with clamp base > 

 
1. Turn the clamp over (to the back) then screw the bolts (M4x20mm). ※Use a 3mm L-wrench to screw the bolts. 

                
 
2. Turn the clamp over (to the front) then pull out the clamp base. 

                   
 
  

Clamp base 
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3. Remove the clamping pins then secure the material to the V groove of clamp without clamp base. 
 (See picture below for reference). 

           
                                <Clamp without clamp base> 

      

 
<Cylinder material>                              
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[Height Adjustable Clamp]  
Height adjustable clamp is used to adjust the height of your material. 

 
 
 
 

Height adjustable 
clamp 

(CP-252) 
 

1EA To adjust the height of the clamp. 

 
1. Turn the Height Adjustable clamp clamping knob counterclockwise to detach the Multipurpose Clamp.  

 
 

2. Turn the clamping knob counterclockwise to detach the height adjustable clamp. 

 
 

3. Attach the multipurpose clamp then fasten it by turning the clamping knob clockwise. 

             
  

Height Adjustable clamp clamping knob 
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[How to adjust the height of the clamp] 

※Optional device; sold separately 
Below are instructions on how to adjust the height of the clamp according to the thickness of the material. 

Spacer block 
(CP-250S) 

 

1SET To adjust the height of the clamp. 

 
1. Turn the clamping knob counterclockwise to detach the clamp. 

         
 

2. Turn the clamp over (to the back) then screw the bolts (M4x20mm). ※Use a 3mm L-wrench to screw the 

bolts. 

                         
 
3. Once the bolts are removed, turn the clamp over (to the front) then pull out the clamp base.  
Then, reassemble the spacer block to pin. 
 

                        
                                                                              <After removed clamp base> 

 

                       
<Clamp Structure 1>                                        <Spacer block>  

Clamp base 
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※ After secure the spacer block, then secure the material to the V groove of clamp. 

         
 

4. Screw the spacer block fixing bolt (M4x20mm). ※Use a 3mm L-wrench to unscrew the bolts. 

         
 
5. Secure the base clamp by attaching it to the pins. 

                   
 
6. Turn the clamp over (to the back) then unscrew the bolts (M4x40mm).  

※Use a 3mm L-wrench to unscrew the bolts. 

                
     <Back of the clamp>  
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※ To assemble or reassemble the spacer block, use the appropriate bolts. Be sure to use and secure the 

spacer block using the correct type of bolts.  

                                                      
<Spacer block fixing bolt- M4x20mm>         <Clamp base fixing bolt- M4x40mm> 
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[Optional items for Multipurpose Clamp]  

-Pin clamp(※Optional device; sold separately) 

 

Pin clamp 
(CP-80) 

 

1SET To hold materials with different shapes in place. 

Pin 
(CP-172)  5EA To hold materials with irregular shapes in place. 

Wrench bolt 
(M4x6)  

5EA To fasten the clamp. 

L-wrench(3mm) 
(CP-L30)  

1EA For tightening/unscrewing the bolt. 

 

         
 

- Cutlery clamp (※Optional device; sold separately) 

 

Cutlery clamp 
(CP-83) 

 

1SET To firmly hold spoons in place. 
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- Watch adapter (※Optional device; sold separately) 

 

Watch adapter 
(CP-84) 

 

1SET To firmly hold watch in place. 

Wrench bolt  5EA To fasten the adapter. 

L-wrench(3mm) 
(CP-L30)  

1EA For tightening/unscrewing the bolt. 

 

       
 

- Bracelet adapter (※Optional device; sold separately) 

 

Bracelet 
adapter 
(CP-85) 

 

1SET To firmly hold bracelets in place. 

Pin 

 

4EA To secure the adapter. 
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- Bar necklace adapter(※Optional device; sold separately) 

 

Bar necklace 
adapter 

(CP-166) 

 

1SET 
Jig for holding materials with narrow width (about 2-
3mm) in place. 
(Used for securing pendants, bar necklaces, etc.)  

Pin 

 

4EA To secure the adapter. 

 

 
 
*Materials like bar necklaces or pendants may come off easily when attaching to the jig. Press the 
material with your finger to secure it to the jig and be sure to not let your finger get caught while 
pressing.  
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- Curved tag adapter (※Optional device; sold separately) 

 

Curved tag 
adapter 

(CP-182) 

 

1SET 
Jig for holding curved materials in place. 
(Used for securing curved pendants, chain 
bracelets, etc.)  

Pin 

 

4EA To secure the adapter. 
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2) Rotary Clamp  

※Basic Installation 
 
BB-S7’s package includes a rotary clamp that is used for engraving the inside and outside of a ring. 

     

 

[How to activate ring engraving mode] 
 
Press the rotary clamp button to activate ring inside/outside engraving mode.  

                

                
 

[How to secure the ring in place] 
 
When engraving the outside 
Place the ring onto the finger chucks. Rotate the rotary clamp to outward-inward directions to lock and secure the 
ring in place. Make sure that the ring is firmly attached and locked so it won’t fall off or spin during operation. 

                   
 

When engraving the inside 
Insert the ring in between the finger chucks. Rotate the rotary clamp to inward-outward directions to lock and 
secure the ring in place. Make sure that the ring is firmly attached and locked so it won’t fall off or spin during 
operation. 
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[Finger Chuck Types] 
 
There are three types of finger chucks available to match the shape and size of the ring. 
 

             

         Flat chuck finger          Round chuck finger (wide)  Round chuck finger (narrow)
 ※Included in the package      ※Included in the package       ※Sold separately   

                                                         

 
[How to replace finger chucks] 
 
Choose the appropriate finger chucks for your ring. Insert the finger chucks into the holes then fasten them tightly 
with the use of a finger chuck spanner. ※The finger chuck spanner is included in the package. 
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3) Tailstock 
※Optional device; sold separately 
 
Tailstock is used to firmly hold cylindrical materials in place. It is specifically used to avoid objects with cylindrical 
shapes such as pen, tumbler and wine glasses to tilt to one side during engraving process.  

 
 
-Height (from bottom to central axis): 69mm 
-Lateral distance (from left to right): 109.5mm 
 
To set up the tailstock the following tools are needed: 
 

Tailstock 
(CP-251) 

 

1EA To hold pens in place.  

Pen adapter 
(CP-251P) 

 

1EA 
To hold pens in place; it goes with a 
tailstock. 

Tailstock fixing 
bolt 

(CP-251B)  
1EA For fastening the tailstock. 

Pin 
(6Ø x25mm) 

 2EA To secure the tailstock. 

 

[How to set up the tailstock] 

 
 
 
1. Insert the pin into the pin holes. 

        
 
  

Pen adapter 

Tailstock slide fixing bolt 

Pen adapter fixing bolt 
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2. Secure the tailstock with a tailstock fixing bolt. 

         
 
3. Use the finger chucks of the rotary clamp to clamp your material. Once your material is clamped, push the 
tailstock to the right side until it touches the tip of your material. ※The device can slide left to right/right to left. 

          
 
4. Fasten the tailstock slide fixing bolt to secure your material. 
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(3) Keypad 
 

  

Display Status display 

Operation Buttons Activate the operations intended to perform 

 

 

Direction 

Key 

(X,Y/Z/A) 

Engraving area adjustment  

• Direction:  (X) Moves X axis 

 (Y)(Z)(A) Moves Y/Z/A axis  

※Axis movement can be changed by using the operation buttons. 

 

Vacuum 

ON/OFF 

Chip collector power button 
 

• Automatic control: The device starts automatically once the engraving 

operation begins and stops automatically once the engraving operation is 

completed.  
 

• Manual operation: Automatic control is deactivated if the device is 

manually switched on. Once the engraving operation is completed, the 

device should be manually turned off. 

 

We strictly advise our users to use the Chip collector during engraving 

operation for safety. The Chip collector prevents exposure form harmful 

inhalable particles and debris like metal chips and dusts which may cause 

eye injury if they get stuck in the eye or respiratory problems if inhaled. 

 
Start 

Start marking button 

• Start marking: Long-press (for 2 seconds) the button to start 

marking. 

• Repeat marking: Press the  button to finish marking, then double-

press (tap twice) the  button to repeat marking. 

• Menu: Press OK when using the menu. 

 
Menu Enter the menu mode. 

 
Stop Stops/cancels marking. 

  

Display 

Operation   

Buttons 
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(4) Menu 

To enter Menu mode, press  button. Select a menu item using the  and  buttons then press  

button to enter the menu item. 
 

1. Tool Change Changes the tool. 

2. Select Origin Sets the current position to the clamp origin. 

3. Calibration 

1. Touch Sensor Adjusts touch sensor settings. 

2. Pointer/Flat Adjusts pointer/flat settings.  

3. Pointer/Rotary Adjusts pointer/rotary settings. 

4. Pointer/L-Tool Adjusts pointer/L-Tool settings. 

4. Measure Z-Ref 

1. Height Only 

2. Horizontal(X) Slope 

3. Vertical(Y) Slope 

4. Plane(XY) Slope 

*In rotary mode, only [1. Height Only] is enabled. 

5. Ring Inside Area Check 

Sets a method for checking the inner diameter 
engraving area:  

1. L-tool 

2. Laser pointer 

6. Chuck Revolution Rotates the rotary chuck. 

7. Adjust 
Brightness 

1. Status LED Adjusts status LED brightness  

2. Inside LED Adjusts inside LED brightness 

3. Pointer Adjusts focus laser pointer brightness 

8. Vacuum Setup 

Sets the Chip collector function. 

-Set to automatic control. 

-Set the Chip collector type: Dry/wet type 

9. Tool-Pos Recording 
Records your current location; set whether to 
activate or not. 

10. Auto Zref on Repeat 

Sets Auto Zref method for repetitive engraving:  

1. No measurement 

2. Height measurement 

3. Height measurement + area check 

11. Front cover  
Selects whether to use the front cover or not.  

※Optional device; sold separately 
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(5) Display 
The display shows the status, functions, mode, and check messages. Icons are displayed differently depending 
on the selected function. The four buttons at the bottom represent different functions and each function vary 
depending on the selected mode. 
 

[Standby-Flat] 

 
 

                      
 

Status 

 
Bluetooth Icon appears when Bluetooth is activated 

 

Auto Zref on 
Repeat 

• : No measurement 

• : Height measurement only 

• : Height measurement + area check 

 

Chip collector 
Power 

Chip collector ON/OFF: Icon does not appear when OFF 

 
Focus Pointer Laser pointer ON/OFF 

 
Front Cover 

Selects whether to use the front cover or not.  

※Optional device; sold separately 

XY:#1-C X-Y Origin 

X-Y origin 

•[#1]: Clamp No. (1-5) 

•[C]: Origin No. (C: Center; origin No.: 1-8) 

 

Mode 

 
Flat Mode Switches to flat mode 

 
Rotary Mode 

Switches to Rotary mode 

• The mode changes in sequence (OUTER DIAMETER → 
INNER DIAMETER → OUTER DIAMETER) in a loop whenever 
the button is clicked. 
• Switched to the INNER DIAMETER mode instantly if double-
clicked 

 
Tool change Switches to tool change mode 

 
Auto focus 

Activates camera auto focus position 

• Auto moves to view position after height measurement 

• Refreshes the camera display at MagicEngrave. 

※Variety of features available for use once MagicEngrave software 

is enabled. 

 
  

Button 

Status 

Mode 
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[Move Mode – Flat] 

Press one of the  buttons in the [STANDBY] mode to activate [MOVE]. 
  

 

                 
 

Message X-Y Position 

The message on display varies depending on the Y-axis 
mode:  

•Y→Y: X-Y axis position 

•Y→Z: Z-axis position 

•Y→A: A-axis position 

 

Mode 

 
Standby Mode 

• Switches to the STANDBY mode  

• Switches automatically to [STANDBY] mode if not in use for 
10 seconds. Press any buttons to activate [MOVE] mode. 

 
Save Origin 

Saves the current position as the XY origin 

*Short-press: Temporary save 

*Long-press: Permanent save 

 Y-axis movement mode:  Save XY Origin 

 Z-axis movement mode:  Save Z Origin 

 A-axis movement mode:  Save A Origin 

 
Laser Pointer Turns ON/OFF the laser pointer 

 

UP-DOWN 
Button Settings 

The mode changes in sequence (Y-axis → Z-axis → A-axis → 
Y-axis) in a loop whenever the button is clicked. 

 

 →   →  

 

  
  

Button 

Message 

Mode 
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[Standby - Rotary] 

 

                 
 

Mode 

 
Rotary Mode 

Switches to rotary mode  

• : Changes to rotary inner diameter mode 

• : Changes to rotary outer diameter mode 

 
Finger Mode 

The mode changes in sequence (Flat finger → Round 
finger → cylinder) in a loop whenever the button is clicked. 

• : Flat Finger 

• : Round Finger 

• : Cylinder (Used for cylinder engraving / ring cutting) 

 
 
[Move Mode - Rotary] 

Press one of the  buttons in the [STANDBY] mode to activate [MOVE]. 
 

 

                 
 

Message A-axis Position Displays the A-axis position 

 

Mode 

 
Standby Mode 

• Switches to the STANDBY mode  

• Switches automatically to [STANDBY] mode if not in use for 
10 seconds. Press any buttons to activate [MOVE] mode. 

 
Save Origin 

Saves the current position as the XY origin 

*Short-press: Temporary save 

*Long-press: Permanent save 

• If  (A-axis mode): If the laser pointer is ON, the laser 
pointer position of the current finger is saved as the origin.  

• If  (Z-axis mode): The SAVE ORIGIN icon changes to 

‘ ’, and the curent Z-axis position is saved as the origin. 

  - Outer diameter mode: Z-axis origin of outer diameter 

  - Inner diameter mode: Z-axis origin of inner diameter 

Mode 

Button 

Button 

Message 

Mode 
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UP-DOWN 
Button Settings 

The mode changes in sequence (A-axis → Z-axis) in a loop 
whenever the button is clicked. 

 

 →  

 

[Engraving Mode] 
 

 

                    
 

Mode 
 Engraving Speed 

Control 

Reduces engraving speed by 1mm/s whenever the button is 
pressed. 

 

Increases engraving speed by 1mm/s whenever the button is 
pressed. 

 

[Pause] 

 

                    
 

Mode 

 

Return back to 
Previous position 

Returns back to the previous position and resumes 
engraving. 

 
Tool Change Switches to tool change mode 

 
Resume Resumes engraving. 

 

  

Mode 

Button 

Mode 

Button 
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(6) Status indicator 
The status indicator is placed at the bottom left side and bottom right side of the machine. It is used to indicate the 

status of the device.  
 

 
 

 

The machine displays flashing or blinking lights to show its current status. The lights displayed indicate the 

following status:  
 

Status Blinking Interval 

Waiting  

Engraving  

Operating  

Notification  

Error  

 

Long-press button (for 2 seconds) to enter menu mode. 

Select [7. Adjust Brightness] then press  button. 

7. Adjust 
Brightness 

1. Status LED Adjusts status LED brightness  

2. Inside LED Adjusts inside LED brightness 

3. Pointer Adjusts focus laser pointer brightness 

Select [1. Status LED] then press  button. 

Adjust the brightness using the (Direction X) buttons. 
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(7) Switching Tools 
 

Do not let any of your body parts or any foreign objects get caught in the machine during 
operation. The tools of the machine are sharp, and may cause serious physical injury. 

 
 

[Spindle] 

Name Picture Quantity Usage 

T-wrench 

(2.5mm) 
 

1EA 
Tool for tightening/unscrewing of 

bolt. 

 

As shown below, insert the 2.5mm wrench into the fixing bolt. Turn the wrench to the left to unscrew bolt. To 
prevent the tool from falling to the floor, grab tool with your hand then pull it out. Once the tool is removed, replace 
it with a new tool then secure it using a wrench for tightening bolts. ※See package contents 

 

 
 
When unscrewing the tool fixing bolt, hold the tool with your hand while unscrewing to avoid the 
bolt from dropping on the floor. 
 

 

[L-Tool] 

Name Picture Quantity Usage 

L-wrench 

(1.5mm)  1EA 
Tool for tightening/replacement of 

bolt. 

L-tool fixing bolt 

(M3x4)  3EA L-tool tip fixing bolt 

 

As shown below, insert the 1.5mm wrench into the fixing bolt. Turn the wrench to the left to unscrew bolt. To 

prevent the tool from falling to the floor, grab tool with your hand then pull it out. Once the tool is removed, replace 
it with a new tool then secure it using a wrench for tightening bolts. ※See package contents 

 

\  

13~20mm 
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4. Installation 
※ Please follow the instructions below for proper installation of the machine, software and other devices. 

※ The software program requires Windows OS 7 or higher.  

 

(1) Machine Installation 
 

BB-S7 cannot operate alone as a desktop engraver. It cannot proceed to engraving and cutting operation without 

the use of a computer and a software. 

 

The machine should be connected to a personal computer for the machine to operate. The software provided 

along with the machine must be installed to the computer to run the program for engraving, cutting and marking. 

 

[How to install the machine] 

1. To start the machine, plug its power cable into a grounded outlet. ※See precautions for use for safety. 

2. To connect the machine to the computer, plug in the USB cable on the back of the machine then on the 

computer’s USB port.  

 
     

 

 

 

 

 

 

 

 

  

USB Cable 

USB Cable  Computer 

Power Cable  Outlet 



34 

-Power switch 

 

 
 

 
Power Turns ON/OFF the machine. 

 

 

-Emergency Switch 

※If the machine won’t turn on, check the emergency switch. 

 

          
 

  

Push 

Turn OFF Turn ON 

Turn the button 
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(2) Program Installation 
BB-S7 comes with a software, MagicEngrave program. The program requires the use of Windows OS 7 or 

higher for the software to run. 

 

[How to install the software] 

1. Insert the USB into your computer`s USB port. A notification will pop-up on your screen regarding installation. 

※USB is included in the package. 

2. Follow the instructions below to install the software.  

3. Follow the steps in order until installation is complete.  

4. In case program installation won’t automatically run upon inserting the USB into your computer, go to My 

Computer’s USB drive then run Install program. 

 

1. Setup wizard. 

 

2. Select installation folder. 

 

3. Confirm installation. 

 

4. The file is copied onto the hard disk. 

 

5. USB driver setup wizard. 

 

6. Check [I accept the agreement], then click 
[Next]. 
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6. Check [Status: Ready to use], then click [Finish]. 

 

7. Click [Run MagicEngrave] to run program. 

 

 

- Program Description 

Once the installation is completed, the following icon will appear on your desktop. The description of the icon is as 

follows: 
 

 

  

 

As a design & marking software program, it features the following functions: marking 

design, marking option, Toolpath setting, transfer of Toolpath data. 
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(3) Front Cover  
※Optional device; sold separately 

 
[How to install the front cover]  
 
1. Set the [Bolt (M4x12) – M4 Washer – M4 Spring washer x 2] in order. 
 

 
 
 
2. Secure the [step 1] with spacer. Secure the spring washer so that it fits into the front cover hole. 

 
 
3. Secure the cover stopper with bolt (M4x6). 

 
 
4. Secure the other side in the same way.  

  

M4 Spring washer x2 

M 4washer x1 

Bolt(M4x12) 

Spacer 

Front cover 

Front cover hole 

Side: When using tailstock 
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5. To enable Front Cover function, press button on the keypad to enter [MENU]. Then, select [11. Front 
Cover] option on the menu. Front Cover icon will be displayed on the LCD screen (as shown below) once it’s 
activated. 
 

 
 
6. Check the positioning of the head and the clamp. Front Cover open and close function is disabled when the 
head is positioned at the right end (of the machine) and the clamp at the front.  
 
[How to position the head and the clamp]  
 

-Standby mode: Press button on the keypad to move the head and the clamp to a position where the 
Front Cover can be opened and closed.  
 
-Auto-positioning of the head and the clamp: The head and the clamp are automatically positioned upon 
completion of initial marking (i.e., when the engraving operation is completed). 
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(4) IO Port 
※External IO port input to the machine is at 5V, use 5mA or less. 

BB-S7 uses a LAN cable to control operation by receiving an external signal through the IO port. 
 

        
 

OUT 5V DC OUT Requires a DC 5V output to connect. 

IN START/STOP Starts or stops engraving operation when DC 5V is connected. 

OUT VACUUM ON/OFF 
Chip collector ON/OFF output status:  
DC 5V output: ON; GND output: OFF 

OUT Universal Output Universal output port for DC 5V output and external devices. 

IN 
Serial 

Communication 
Transmission 

Receives serial communication from external devices. 

OUT 
Serial 

Communication 
Transmission 

Transmits serial communication from external devices. 

**OUT: Signal received from external devices  
**IN: Signal received by the machine 

  

IO port 
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(5) Back Cover 
 

-Optional (Sold separately) 
 

Back Cover 
(CP-253BB)  

1EA Back Port Cover 

Square Magnet 
 

2EA To secure the back cover. 

Bolt 
(M3x8mm)  

3EA To secure the square magnet. 

 
1. Assemble the back cover then attach it to the back side of the machine. 
 

 
 
2. Insert the bolt into the square magnet then screw it into the machine. 
 

          
 

 
3. Attach the back cover. The back cover is secured by the square magnets. 
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5. Operation of the Marking Machine 
BB-S7 performs self-diagnosis upon turning ON. During self-diagnosis, the machine checks the following in order:  

 

(1) Self-diagnose Procedures 
1. If a certain axis is detected by the sensor, it moves away from the detected area.  
2. Checks probe sensor and returns to the Origin point 
3. Checks Z-axis sensor and returns to the Origin point 
4. Checks Y-axis sensor and returns to the Origin point 
5. Checks X-axis sensor and returns to the Origin point 
6. Confirmation sound and standby 

 
If no problem is found, it goes into standby mode with a confirmation sound. 
 

(2) Marking Procedures 
 

1. Turn on the marking machine. 

 

    ※ If the machine does not turn on, check the emergency switch. 

 
 

2. Run the program to connect it to the machine. 

 
 

 

3. Place your material on the work area.   
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4. Make your design then create a toolpath. 

 
 

 

5. Click the [Machine] button to send the marking data. 

 
 

6. Press start button on the machine to begin the engraving process. 
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Before Using the Program 
 
The property of the object (i.e., size, shape, position, etc.) can be changed or modified when the object is 
selected.  
 

 
 
 
The mouse cursor display changes depending on the function (i.e., text input, resize, select, etc.). 
 

  

Object is selected 

Object handle 

Text input 

  Resize    Move 

Adjust character gap 



44 

Program Usage Description 
Shown below is the window that will appear once the program starts running. Icons displayed on the window may 

vary depending on the selected mode. The name of each category is as follows: 

 

◈ Program Screen 

 
 

◈ Text Input Mode 
 

Click   [Text Input] button on the upper center of your screen or double-click on the composition area to 

input text. 

  
  

Text property 

Work area 

Template 

list 

Menu 
Toolbar 

Template category 

Screen zoom in/out tools 

Data 

output 

Cursor (text input mode) 
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◈ Object Selection Mode 

After entering the text, use  [Selection] button with your mouse or right-click the text on the composition 

area to switch to selection mode. To switch to text input mode, double-click on the selection mode.   

 

  

 

 

◈ Object Rotation Mode 

To activate object rotation mode, double-click the text while in selection mode.   

  
  

Text property 

Object selection mode 

Rotation registration information 

Object rotation mode 
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1. Toolbar 
 

◈ Alignment Tools 

 

 

 
 

 [Line/Curve]  

 

Click a certain point then hold your mouse and drag to make a dot line 

appear. Designate the distance then right-click to create a straight line. 

Then, press “Ctrl” key on the keyboard and move the mouse to create a 

horizontal line or a vertical line.  

 

Click a certain point and designate a distance. Hold your mouse and drag 

to make a curve appear. Right-click to create a curve. 

 

 [Circle/Oval/Pie] 

 

Click the work area then hold your mouse and drag to designate the size of 

a circle. Press “Shift” key on the keyboard then drag your mouse to create a 

perfect circle.  

 

Click  button on the circle object property window to convert to arc. 

The start/end of an angle of an arc can be assigned, or adjusted by 

dragging the start/end with the mouse. Click  button to 

create a reversed arc image.   

 

Click  button on the circle object property window to convert to pie (a 

filled arc). The start/end of an angle of a pie can be assigned, or adjusted 

by dragging the start/end with the mouse. Click  button 

to create a reversed pie image. 
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 [Rectangle] 

 

Click the work area then hold your mouse and drag to designate the size of 
a rectangle. Press “Shift” key on the keyboard then drag your mouse to 
create a square. 

 

The curvature of each edge can be assigned on the rectangle object 
property window. Or, by dragging the edges of the rectangle with the 
mouse, the edges convert into round corners. 

 

Click  button on the rectangle object property 
window to adjust the curvature of each corner individually. 

 

 [Polygon] 

 

Click the work area then hold your mouse and drag to designate the size of 

a polygon. The number of vertices can be assigned on the polygon object 

property window. 

 

 [Mirror] 

       
Produces mirrored image. 

 

 [Rotation] 

           

Double-click to select rotation then hold your mouse and 
drag to rotate the image. 

 

 [Invert color] 

         
Inverts the color of the image. 

 

 [90˚CW] 

          

Rotates the image by 90˚.  
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 [Horizontal center in page] 

          
 

 [Vertical center in page] 

          
 

 [Center in page] 
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 [Alignment options] 

 
 

 

 

 

Alignment 

 
Align to the left of base object 

 
Align to the center of base object 

 
Align to the right of base object 

 
Align to the top of base object 

 
Align to the center of base object 

 
Align to the bottom of base object 

Adjust horizontal gap 
 

Align horizontal gap between objects evenly 

Adjust vertical gap 
 

Align vertical gap between objects evenly 

Same size 

 
Make same width 

 
Make same height 

 
Make same size 

Alignment 
 

Horizontal center in page 

 Vertical center in page 

Order 
 

Bring to front 

 
Send to back 
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◈ Object Tools 

 

 

      
 

 [Barcode] 

 

Create a barcode object. 
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 [Design sample] 

 

Import design sample or save current object as design sample. 

 

 

What is a Design Sample? 
Design sample is the object saved in the design sample library. Design samples can be easily 

and quickly imported from the design sample library and edited freely. 
 

 [Selection] 

 

Use selection mode to modify the object’s property or adjust its size and position. To use, click the object created 

in the work area then adjust its property. To input text, right-click. 

        
[Object selected]                  [No object selected] 

 

 [Text input] 

To input text, click  button then click the object in the work area or, simply double-click to enter text. 
 

               
Cursor (Text input mode) 

 

To modify the object’s font style and size, click  button then hold and drag the character/s with the mouse.  

 
 

[Mouse drag] 
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Click button to create a text box. Then hold and drag the mouse to adjust the size of the text box. The size 
of the text box limits the number of character input.  
 

 
 
A blinking cursor display indicates ‘enter text.’ 

 
 
Or, go to [Menu → Insert → Text box]. 

 
 

 [Circular text] 

 

Create text objects along a circle. 

 
  

[Mouse Drag] 
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 [Drawing pen] 

 

Hold and drag the mouse to draw character/s to create an object with the use of drawing pen. The drawing line’s 

thickness can be adjusted in the drawing object property window. 

 
 

 [Outline stroke of object] 

Apply outline stroke to the object. 

     
 

    

    

 

 [Auto Inverts Color] 

 

The color of one object auto inverts to opposite color to contrast the other object’s color when overlapped.  

Click  button then select the object to be placed over the target object. Upon pacing the selected object 

over the target object, the selected object auto inverts to an opposite color.  
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For texts, click the  button then drag the selected text and place it over the target object.  

 
 

 

 
 

 

If the color is not inverted, go to [Layout menu → Order → Top Most] then place the selected 

object over the target object. 

 

 

 [Image] 

 

Import image (e.g., bmp, jpeg, gif, png … etc.). 
 

 

 [Line eraser] 

 

Erase the line of a created object.  

Click the object to be erased then hold and move the mouse over the line to erase. (Take note that some objects 

may not be erased with the Line eraser tool). 
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◈ Toolpath 
※Please refer to [4. How to engrave for each toolpath] for details. 

 

 
 

What is a Toolpath? 
Toolpath is a path where the tool passes by for marking.  

Toolpath is usually displayed in red color and the marking tool moves along the path as it 

engraves.  
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◈ Origin Point Setting Tools 

 

 
 

 [Left top origin point]  [Left bottom origin point] 

  

 [Center origin point] 
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◈ Basic Tools 

 

 

 
 

 [New document] 

Open a new page.  

 
 

 [Open] 

Open a file in “*.dgn” file format. 

Select a file on the “Open” window and click “Open” button. 

 

 [Save document] 

Save the design created on program as “*.dgn” file format. 

Choose the location (folder) in which the file will be saved then enter the file name before clicking “Save” button. 
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 [Print] 

Print the design created on program. 

 

 [Cut]  

Cut the selected object.  Click cut  on the menu or press Ctrl+X on the keyboard. 
 

           
Ctrl + X                 Ctrl + V 

 

 [Copy] 

Copy the selected object. Click  on the menu or press Ctrl+C on the keyboard. 
 

           
Ctrl + C                  Ctrl + V 

 

 

[Duplicate Horizontally or Vertically] 

Click  icon in toolbar to multi-copy the same object at once, or go to [Edit → Copy → Duplicate Horizontally 

or Vertically…]. 
 

    
 

            
 

 [Paste] 

Paste the cut or copied object. Click  on the menu or press [Ctrl+V] on the keyboard. 
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 [Undo / Redo] 

 

-Undo: To reverse the action recently done.  

Go to [Menu] → [Tool] → [Option] → [General] to adjust the number of undo action. 

 

                  
 

-Redo: To restore the action that was previously done.  

                  
 

                                                                        

 

  

Change font Undo 
 

Change font Undo 
Redo 
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◈ Zoom in/out/move Tools 

 
 

 
 

 [Zoom in] 
The screen appears much larger and nearer. 

             
 

 [Zoom out] 
The screen appears much smaller and farther. 

                
 

 [Zoom in/out ratio] 
Select the desired screen ratio. The size of the screen will appear base on the selected ratio. 
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 [Magnifier] 
Select a certain spot on the object then hold and drag the mouse to enlarge it.  

                 
 

 [Fit to object] 
Enlarge the object to fill in the screen. 

                
 

 [Fit to page] 
Adjust the page size to see the whole work area.  

                  

 [Panning] 
Drag the screen with the mouse to move it. 

              
 

  



62 

2. Text Object Property 
 
Select the text object to see its property. The property of the object will appear on the left side of the screen.  

 
 

 [Font] 

Designate font. Click “Preview” button or the arrow beside it to designate font. 

 

 

 
 

 

 
 

*Right-click the font preview window to see menu. Click “Show Font List” 

then designate the fonts to be shown in preview.  

 

 

 [Size] 

Adjust the size of the selected text. Click  [size] button to adjust the size of the font or the arrow beside 

it.  

 

                 
 

[Mouse right button click] 
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 [Bold] 

Change text style to bold.  

               

 [Italic] 

Change the text style to italic. 

               

 [Reduce or increase font weight by one level] 

Adjust the weight of font. 

                     
 

 [Symbol] 

Insert symbols. 

 
 

   [Text change] 

Modify the entered text. Edit the text on the text field or click   button to add long texts. 
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 [Text Alignment] 

 

 [Align to left] 

Align characters to the left in the text box. 

 

 [Align to center] 

Align characters to the horizontal center in the text box. 

 

 [Align to right] 

Align characters to the right in the text box. 

 

 [Both] 

Align characters evenly to both sides in the text box. 

 

 [Align to top] 

Align characters to the top in the text box. 

 

 [Align to center] 

Align characters to the vertical center in the text box. 

 

 [Align to bottom] 

Align characters to the bottom in the text box. 
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 [Horizontal text] 

Arrange characters horizontally. 

 

 [Vertical text] 

Arrange characters vertically. 

 

 

Move the selected character horizontally (left, right). 

 

 

Move the selected character vertically (up, down). 

 

 

Adjust the width of the selected character. 
 

 

 

Rotate the selected character. 
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 [Position/Size] 

 

 

 

 [Line and Fill Shape] 

 

  

 

Designate the location of the selected object 

 

Designate the size of the selected object 

 

Click “check” to maintain the same ratio for the object’s width and 

height. Click “uncheck” to adjust the object’s width and height 

separately. 

 

 Line thickness of the selected object 

 Line type of the selected object 

 Line color of the selected object 

 
Color filled inside of the selected object 

 Shape filled inside of the selected object 
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3. Rotation Tool Property 
 

 
 

 [Rotation] 

 

 

 

 

 

 

 

 

  

 

Designate the rotation angle of the selected object. Enter the desired 

angle of rotation or click the up/down arrow buttons.  

 
Rotate selected object according to the angle entered. 

 

Add a new object and rotate it according to the angle entered. 
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4. How to Engrave for Each Toolpath 

 

What is a Toolpath? 
Toolpath is a path where the tool passes by for marking.  

Toolpath is usually displayed in red color and the marking tool moves along the path as it 

engraves.  

 

 [Cut-out toolpath] 
Creates a toolpath that will cut out the selected object. The toolpath boundary will be wider than the boundary of 
the selected object depending on the thickness of the tool. *This toolpath must be used when cutting. 

          
 

 [Outline toolpath] 
Creates a toolpath that will engrave the outline of the selected object. 

          
 

 [Hatching toolpath] 
Creates a toolpath that will engrave the inside of the selected object. 

        
 

 [Single line toolpath] 
Creates a toolpath that will engrave the center line of the selected object. 

           
  

“Single line toolpath” process may cause deviation on center line. 
It is recommended to use fonts with thinner lines to reduce deviation.  
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 [Boundary-line toolpath] 
Creates a toolpath that will engrave the boundary of the selected object. 

           
 

 [Inline toolpath] 
Creates toolpath that will engrave inline of the selected object. 

         
 

The toolpath is created within the borders of the selected object. 

 

 [V-cut toolpath] 
 

Creates a toolpath that will engrave V-cut groove. 

           
 

 [Convert object to toolpath] 
Convert the selected object to toolpath. It’s not necessary to set toolpath settings each time. It will be 
automatically set to its preset values.  

 
  

Inline 

Outline 
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 [Photo impact engraving toolpath] 
Creates a toolpath that will engrave an image with dots. 

          
 

[Scan-line toolpath]  
Creates toolpath that will engrave inside area of the selected object’s boundary. 
“Scan line toolpath” may appear similar to “Hatching toolpath” but it is specifically used to engrave on logos, 
patterns or objects with larger areas. 

           
 

 [Contour line toolpath] 
Creates a toolpath that will engrave the selected object with contour lines. 

         
 

 [Photo halftone engraving toolpath] 
This converts an image into a half-toned image and engraves the object in dots or horizontal lines using a V-cut 
tool. This process is only applied to engraving machines with rotating-spindle function like BB E7, E4 etc.  
 

                   [Dot] 

                             [Horizontal Line] 

What is Half-toned Engraving? 
Half-toned engraving converts light and dark areas of a picture or an image into lines or dots in 
different sizes to express a fine image.  
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 [Simulate toolpath processing] 
Click this button to see the predicted image result of the toolpath processed by the selected tool. 

 
 

 [Show toolpath only] 
Click this button to make the toolpath the only visible object on the screen (while all the other objects are 
temporarily hidden). Click this button again to reveal the other objects.   

        
 

 

5. Create Toolpath 
 

 
 

Tools in [Tool] option may vary according to types of models. 
 

Tool Designate a tool to be used for engraving. Each tool setting value can be 
changed by clicking Edit or Add button. 

Preset 

Hatching gap, depth, engraving speed and others are pre-set for each 
engraving option. It is not necessary to assign each value every time as 
the values is automatically pre-set. Each value can be changed by clicking 
Edit or Add button. 



72 

Direction 

The following hatch lines are applied to hatching toolpath only: 
 

 : A tool path is created in the horizontal direction 

 : A tool path is created in the vertical direction 

 : A tool path is created in the left diagonal direction 

 : A tool path is created in the right diagonal direction 

 : A tool path is created in the cross hatched direction 
 

※ These toolpaths are not recommended to be applied to materials with 

plated surfaces as they may cause possible damage to the material. 

Option 

Depth 

Engraving: Refers to the applied pressure and not the actual engraving 
depth. The higher the pressure is, the deeper it imprints. 

 
Cutting: Refers to the actual engraving depth when using rotary tools like 

end mills, V cutters, etc. 

Z Pitch 

Designate the depth when cutting the engraving depth little by little. This 
option is necessary when cutting thick materials with a thin tool. 
 

 

Hatching 

gap 

Designate hatching gap. 

 
0.1mm       0.2mm      0.3mm 

Margin 

Designate a margin between object outline and toolpath. 

 
0.1mm       0.2mm       0.3mm 

Z Pitch 

Actual engraving 
depth 
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Engrave 

outline 

If this option is checked, a toolpath with an outline is created. If unchecked, 
a toolpath without an outline is created.  

 
with outline     without outline 

Speed 

XY speed Designate a speed at which XY axis will move during the engraving. 

Z speed Designate a speed at which Z axis will move during the engraving. 

Engraving speed is displayed in colors according to tools or engraving options. 
 

Move  
Option 

Z 
clearance 

This designates the height to be applied for the clearance between the tool 
and the surface of material when moving to another engraving location.  
When moving to another engraving location, it is necessary to lift Z axis to 
prevent the tool from coming in contact with the material surface before 
moving.  

 

Z dwell 
time 

This designates no-load rotation time of end-mill and V-cutter after they 
reach the target depth and before moving to X, Y axis point. It is possible to 
damage the tool as rotation speed reduces while engraving. Set up the Z-
dwell time to recover the full rotation speed before engraving. 

✽Recommended time: 0.5 ~1 second. 

Transmit Toolpath output window is displayed 

 
  

Z Clearance 
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(1) Tool: Add/Delete/Edit 
 

Check “Edit” button to see Add/Delete/Edit buttons. 

 
 

  
Designate a name for the tool to be added along with its type and other options like tip width, then click “OK” 
button. The tool will then be added to the tool selection list. 
 

 
 

  
Select a tool to be deleted then click “Delete” button to remove the tool from the list. 
 

            
 

  
Select a tool to modify then click “Edit” button. Click “OK” button to save the modified value. 
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(2) Engraving Option: Add/Delete/Edit 
 
Check “Edit” button to see Add/Delete/Edit buttons. 

 
 

 Enter a name then set the hatching gap, engraving depth and speed. Click “OK” button and the 
option will be added to the selection list. 
 

           
 

 Select an option to be deleted then click “Delete” button to remove the option from the list.  
 

           
 

 Select a tool to modify then click “Edit” button. Click “OK” button to save the modified value. 
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6. Toolpath Object Property 
 
Select the toolpath object to see its property and/or to adjust its speed and depth. The toolpath object property will 

appear on the left side of the screen.  

 

 
 

Depth 

Engraving: Refers to the applied pressure and not the actual engraving depth. The 
higher the pressure is, the deeper it imprints. 

 
Cutting: Refers to the actual engraving depth when using rotary tools like end mills, 

V cutters, etc. 

Z pitch 

Designate the depth when cutting the engraving depth little by little. This option is 
necessary when cutting thick materials with a thin tool. 
 

 

XY speed Designate a speed at which XY axis will move during the engraving. 

Z speed Designate a speed at which Z axis will move during the engraving. 

Z clearance 

This designates the height to be applied for the clearance between the tool and the 
surface of material when moving to another engraving location.  
When moving to another engraving location, it is necessary to lift Z axis to prevent 
the tool from coming in contact with the material surface before moving. 
  

 

Z Pitch 

Actual 

engraving depth 

Z Clearance 
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Z dwell time 

This designates no-load rotation time of end-mill and V-cutter after they reach the 
target depth and before moving to X, Y axis point. It is possible to damage the tool 
as rotation speed reduces while engraving. Set up the Z-dwell time to recover the 
full rotation speed before engraving. 
 

✽Recommended time: 0.5 ~1 second. 

Engrave twice Engrave the design twice.  
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7. NC Data Output 
(1) Transfer the Toolpath Data after Creating a Toolpath 

 

Select a toolpath then click the  “Engraver” button on the top-right of the screen to transfer the 

data of the selected toolpath to the BB-S7 machine. 

 
 

 
On the NC output window, select a measuring method and other options, then click “Start Engraving” button to 

start transferring the toolpath data to the selected machine. 

 
 

Toolpath order 
The toolpaths are put in order if two or more toolpaths are selected 
for engraving. The order can be modified by clicking [Up]/[Down] 
button on the right.  

Surface height  
measurement 

Surface 
height 

Measures material height only. 

 

Skip 
Skips material’s height measurement and allows the use of the 
previous height measurement data if the material has not been 
removed from the clamp during the previous engraving process.  
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Horizontal 
slope 

Measures material’s horizontal gradient. 

 

Vertical 
slope 

Measures material’s vertical gradient. 

 

Surface 
slope 

Measures material’s top, bottom, left and right gradient. 

 

Material surface 

Flat Engraves flat-surfaced materials. 

Uneven Engraves curve-surfaced materials. 

Multiple engraving 

Engraves materials repeatedly in constant vertical/horizontal 
intervals. 
✽A vise is used for this automatic engraving and available for separate 

purchase. 

Simulate engraving 
Displays engraving simulation on the material by using laser pointer 
to ensure that it follows a correct path.  

Adjust engraving position 
Select this option to re-adjust the engraving location. The laser 
pointer then adjusts to the engraving location before engraving. If this 
option is not selected, engraving process will initialize immediately.  

Move to vise automatically 
Move automatically to the flat or rotating vise based on the selected 
template.  

Touch-Mark-Free 
Measurement 

Prevents height measurement points from leaving any marks. 

Turn on External Device Enables automatic external device operation. 
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✽ “NC output” window when selecting ring template.  

 
 

Surface height 

Measures material height. 

 

Multi-point-
measurement 

Measures material height by dividing the whole material into several parts 
(up to 5 times) 

Outside Engraves the outside of the ring. 

Inside Engraves the inside of the ring. 

 
Place the material on the flat chuck finger. 

 
Place the material on the round chuck finger 

 

(2) Transfer the Toolpath Data after Entering Text 
 
Transfer the text data to the engraving machine without creating a toolpath. After creating a text design, click 

 button on the right top of the screen for immediate marking. 
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(3) Camera 
 

Enable the camera function. 

BB-S7 has a built-in camera used for viewing the marking area. The camera captures the actual image of the 

material being engraved then sends the image data to the software along with the material’s size and location, 

allowing users to design, position and adjust the size of their design directly on the material while viewing the 

camera. 

 

[Camera positioning system specifications] 

-Filming area: 90mm x 70mm  

-Filming target: flat surface engraving (not available for rotary engraving) 

-Camera resolution: 1600 x 1200 

-Precision: 0.2mm (*Precision is a calculated number. The actual precision is affected by calibration.) 

 

 
 

   
 

Refresh Refresh the camera image displayed in the MagicEngrave Program. 

Camera On 

 

Enable/Disable the camera function. 

When [Camera on], auto positioning is activated. 

 

AF See 8. Auto Focus for details. 
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Image Adjustment 

Set the camera image options such as contrast, grayscale etc. 
 

 

Camera Viewer 

View the camera image in a new window. 

 

Auto Focusing Sensor 
Set the camera image displayed in the MagicEngrave Program (with 

maximum size restriction). 

Auto Renewal Frequency 
Set the timer the camera image auto displays in the program. 

Timer: 5 ~ 30 seconds 

Camera Selection 

Select a camera device. 

If there are multiple camera devices connected to your PC, the 

camera for laser is automatically set by default or, select the device 

manually. 
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8. Auto Focus 
BB-S7 has built-in auto focusing systems that enable auto focusing on materials to be marked with a material 

height detection camera.  

 

*Click the [AF] button to enable the camera auto-positioning function. 

*Refocusing is required upon changing the material. 

*Features become available once MagicEngrave program is enabled. 

 

 

1. Click [AF] on the program. 
 

 
 

① Clamp moves to the center. 

② Measure the height of the material 

③ Tool moves to the right end of the machine 

④ Software updates the camera image 

 

2. Press the [AF] button on BB-S7 operation buttons then click the [Refresh] button on the program to refresh the 

camera display. 

 

                

                   
 

 

3. To cancel autofocus, press  button on BB-S7 machine. 
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Marking Process 
 

 
 

1. Measure the size and height of your material.  

 
 

2. Place your material at the center of the clamp. 

 
 
3. Select a template that matches the shape or type of your material from the template category. Enter the size of 
your material then click “OK” button. 
 

 
 

Maintain original size The actual size of the registered template is loaded; not the size entered. 

Locate to original 
position 

The template is loaded to where it was initially created.  If this option is 
selected, the template is loaded at the center of work area.  

Fit page size to 
template 

The size of the page is adjusted to the size of the template. 

Height 

Thickness 

Width 
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4. The selected template will appear on the screen. Click  [Text input] button then click at any target 
location to enter text. 
 

 
 

5. Once the text is completed, click  [Selection] button on toolbar. Enable the object selection mode to select 

the entered text then modify the size, font and thickness of the object. Lastly, click  [Center in page] button 

to position the object at the center of the work area. 
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6. Upon completing the design, click  [Hatching toolpath]. 

✽Click  icon on the top right of the screen for immediate marking without creating a Toolpath. 

 

 
 
7. Select an engraving option and tool from “Hatching Toolpath” window and if necessary, designate gap and 

depth before clicking “Create Toolpath” button. 
 

  

                          
 

-Scan line toolpath-                            -Hatching toolpath- 
 
For better engraving quality on large areas (e.g., large fonts or images) use “Scan line toolpath.” 
Although this may require more time to process. 
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8. Toolpath object is created. 
 

  
 
 

9. Click  button.  
 

 
 
10. Once “NC Output” window appears, specify how the engraving material is measured then click “Start 
Engraving” button. 
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11. Once the tool is positioned to the center of the material and the laser pointer turns on, use the direction key 
buttons to position the laser pointer to the engraving area. The area that the laser pointer points to is where the 
actual engraving takes place. 
 

 

Press the direction key buttons to move the laser pointer to the left, top, right and 
bottom areas of the engraving area. (Long press to move the laser pointer 
farther). Check if the laser pointer points to the area on the material where you 
want to engrave. If the laser pointer is out of range, adjust the position using the 
direction keys.  

 

The laser pointer automatically points to the area where the engraving takes 
place (based on the target location on the work area).  
 
When the direction key is pressed, the laser pointer moves to the area to be 
engraved (left, top, right or bottom) from its target location. If the engraving area 

needs to be adjusted to the left, press   key to move the pointer to the left. 

 

 
 
12. After positioning the laser pointer and determining the location of the engraving area, long-press and hold 

 button (for more than 3 seconds) until it beeps to confirm that the machine is ready to engrave then close 
the cover. 
 
  

Work area 
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Ring Inner/Outer Marking Process 
 

 
1. Measure the width and diameter of the ring.  

 

                                         
<Outer marking – Ring outside size>                         <Inner marking – Ring inside size> 

 
2. Insert the ring into the chuck finger (as shown below) then tighten the rotation clamp to firmly secure the ring. 
 

 

           
[Ring outer engraving]          [Ring inner engraving] 

 

[Object position]  

     

 

[Engraving direction]  

The direction of the characters to be engraved on the ring is shown in the picture below. Check the target location 
(where you want your characters to be engraved on the ring) then firmly secure the ring. 
 

 

Rotary 
Fixing 

Part  

1
 

2
 

Width 

Diameter 

Width 

Diameter 

1 

2 
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3. Double click “Ring” template in the object property window. When [Insert Rotary Object Template] window 
appears, select one engraving option: outside or inside. Then enter the width and diameter of the ring and click 
“OK.” 
 

 

4. The template will appear at the center of the screen. Select  [Text Input] on the toolbar then click at any 

target area on the work area to enter the text to be engraved. 

 

 
 

5. After entering the text, click  [Selection] on the toolbar to enter the object selection mode. Select the text, 

then edit its size and font. To place the text at the center of the work area, click  [Center in Page] button. 
 

    
 

What is Handle for adjusting gaps between characters? 
Handle for adjusting gaps between characters is a function that adjusts gaps between characters 
by dragging characters to target positions.  

Handle for 
adjusting 

character gap 
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6. Upon completing the design, click  [Hatching Toolpath] button.  

✽Click  button on the top right of the screen for immediate marking without creating a Toolpath. 

 

 
 
7. The “Hatching Toolpath” window will appear (as shown in the picture below). Select the tool, toolpath gap and 
depth then click “Create Toolpath” button. 
 

 
 
8. The “Toolpath” object is created with red lines marked or filled on each text (as shown in the picture below). 
Scroll up the mouse wheel to zoom in the image of the toolpath object to check the line style. You may delete the 
toolpath object and create a new one if the toolpath is not your preferred style. 
 

 
              [Toolpath creation] 
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9. After selecting your preferred toolpath, click  button. 
 

 
 
10. Once “NC Output” window appears, specify how the engraving material is measured then click “Start 
Engraving” button. 
 

 
 

Surface height 

Measure material height. 

 
 

Multi point 
measurement 

Measure material height by dividing the whole material into several parts (up 
to 5 times) 

Outside Engrave on the ring’s ring outer diameter. 

Inside Engrave on the ring’s ring inner diameter. 

 
Place the material on the flat chuck finger. 

 
Place the material on the round chuck finger 

 



93 

11. Once the tool is positioned to the center of the material and the laser pointer turns on, use the direction key 
buttons to position the laser pointer to the engraving area. The area that the laser pointer points to is where the 
actual engraving takes place. 
 

 

Press the direction key buttons to move the laser pointer to the left, top, right and 
bottom areas of the engraving area. (Long press to move the laser pointer 
farther). Check if the laser pointer points to the area on the material where you 
want to engrave. If the laser pointer is out of range, adjust the position using the 
direction keys. 

 

The laser pointer automatically points to the area where the engraving takes 
place (based on the target location on the work area).  
 
When the direction key is pressed, the laser pointer moves to the area to be 
engraved (left, top, right or bottom) from its target location. If the engraving area 

needs to be adjusted to the left, press   key to move the pointer to the left. 
 

 

 
12. After positioning the laser pointer and determining the location of the engraving area, long-press and hold 

 button (for more than 3 seconds) until it beeps to confirm that the machine is ready to engrave then close 
the cover. 
 
 

  

Work area 
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Photo Marking 
 

 
 

What is Photo Marking? 

Photo marking is a marking method that marks the shade of an image with dots. 

 

 

1. Place the material on the clamp. 

 

2. Click  [Image] to import an image for marking.  

 
 

3. Adjust the size and location of the image. 

 
 

[Mouse drag] 
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4. [Clipping Mask] feature enables clipping or cropping of the target image. Drag the mouse over the image then 

create a shape.   

  
 

5. Drag and hold the mouse to select the target image or select [Menu] → [Edit] → [Select All]. 
 

 
 

6. Then select [Menu] → [Transform] → [Make Clipping Mask]. Only the cropped image (target image) remains. 
 

 
 

[Mouse drag] 

[Mouse drag] 
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The original image is saved; not deleted or cropped out. 

7. Click  [Photo Impact Engraving Toolpath] button. 

✽Click  button on the top right of the screen for immediate marking without creating a Toolpath. 

 
 

8. Adjust marking options in photo marking option window. 

 

✽ The black area is not engraved; only the cropped image. 
 

During photo marking process, the brighter area (white area) of an image is not visibly expressed with 

dots unlike the darker area where dots are highly visible with higher marking quality. Therefore, it is 

recommended to adjust the brightness of an image to darker. Normally, a dot ratio of 10-20% provides 

the best marking quality for a portrait. Take note that the image’s optimal conditions vary depending on 

the brightness of background of the image. Check image preview then adjust the image’s brightness and 

dot ratio. If ‘image adjustment’ is confusing, click “Recommend the best” button to automatically adjust 

the image. 
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9. Click “OK” button to create a toolpath for photo marking. Set the laser marking option then click  

[Engraver] button. 

 
 

During marking process, the white area of the image appears with dots. The image result of the toolpath 

is shown as a negative image. 

 

10. Once the tool is positioned to the center of the material and the laser pointer turns on, use the direction key 
buttons to position the laser pointer to the engraving area. The area that the laser pointer points to is where the 
actual engraving takes place. 
 

 

Press the direction key buttons to move the laser pointer to the left, top, right and 
bottom areas of the engraving area. (Long press to move the laser pointer 
farther). Check if the laser pointer points to the area on the material where you 
want to engrave. If the laser pointer is out of range, adjust the position using the 
direction keys. 

 

The laser pointer automatically points to the area where the engraving takes 
place (based on the target location on the work area).  
 
When the direction key is pressed, the laser pointer moves to the area to be 
engraved (left, top, right or bottom) from its target location. If the engraving area 

needs to be adjusted to the left, press   key to move the pointer to the left. 

 

 
11. After positioning the laser pointer and determining the location of the engraving area, long-press and hold 

 button (for more than 3 seconds) until it beeps to confirm that the machine is ready to engrave then close 
the cover.  

Work area 
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Pen Engraving Process 

 
 

-Tailstock is sold separately. 

 
1. Measure the width and diameter of the pen. 

 
 
2. Secure the pen to the engraver by using a pen clamp.  

 
 

 
The pen jig may differ depending on model types. The instructions are almost the same for all 
types of engravers regardless of the type of jig used. Be sure to follow the instructions below 
to determine the correct positioning of the pen when engraving.  

 
 
3. Select a pen template in the object property window. Enter the width and diameter of the pen then click “OK” 
button. 

 
 

  

Diameter 

Width 
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4. Once the template appears, click [Text Input] on the toolbar. Click the work area then enter text. 

  
 

5. After entering the text, click  [Selection] on the toolbar to enter object selection mode, then adjust the 

size and font of the text.  Click  [Center in Page] button to place the object at the center of the work area. 

 
 

6. Upon completing the design, click  [Hatching Tool path].  

✽Click  button on the top right of the screen for immediate marking without creating a Toolpath. 
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7. Select engraving option and tool from the “Hatching Toolpath” window. If necessary, designate the hatching gap 
and depth then click “Create Toolpath” button. 
 

 
 
8. “Toolpath” object is created. 
 

     
 

9. Click  button.  
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10. Once “NC Output” window appears, specify how the engraving material is measured then click “Start 
Engraving” button. 
 

 
 
11. Once the tool is positioned to the center of the material and the laser pointer turns on, use the direction key 
buttons to position the laser pointer to the engraving area. The area that the laser pointer points to is where the 
actual engraving takes place. 
 

 

Press the direction key buttons to move the laser pointer to the left, top, right and 
bottom areas of the engraving area. (Long press to move the laser pointer 
farther). Check if the laser pointer points to the area on the material where you 
want to engrave. If the laser pointer is out of range, adjust the position using the 
direction keys. 

 

The laser pointer automatically points to the area where the engraving takes 
place (based on the target location on the work area).  
 
When the direction key is pressed, the laser pointer moves to the area to be 
engraved (left, top, right or bottom) from its target location. If the engraving area 

needs to be adjusted to the left, press   key to move the pointer to the left. 

 

 
12. After positioning the laser pointer and determining the location of the engraving area, long-press and hold 

 button (for more than 3 seconds) until it beeps to confirm that the machine is ready to engrave then close 
the cover. 

 

  

Work area 
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Engraving Curved Materials 
Scratch on the surface of a curved material is likely to be caused by the tool touching the surface of the material 
when it moves. This can be avoided by entering the thickness of the material’s surface to set the Z-movement 
height automatically. 
 

1. Create a toolpath then click  button. 

 
 
2. Once “NC Output” window appears, click “Uneven” to see different kinds of curved materials. Select a shape 
that resembles the shape of the material then enter its thickness (the thickness of the area to which the engraving 
is applied) then click “Start Engraving” button. 
 

   
 
 

 
 
 
 

 
 
  

Enter the thickness of the 

part to be engraved. 
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Layout of Text in a Circle 
 

Texts can be arranged around a circle by using circular text object. 

 

  
 

 [Circular Text]  

Click  button to display “Circular Text” window. Assign a direction and an angle, enter the text and size, then 

click “OK” button. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 



104 

 [Circular Text- Top/Bottom]  

      

 [Adjusting layout angle] 

Drag the first character [R] or last character [y] in the text to adjust the angle of the layout. 

 

          
 

 

 

 

 

Drag other characters with the mouse to adjust the distance to the center of the circle. 

                          
 

 

Drag with mouse to adjust 

the layout angle. 

Drag with mouse to adjust 
distance from the center of the 

circle. 
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Layout of Text in a Curve 
 

1. Click the  [Line/Curve] button. 

 

2. Left-click to display the dotted lines then designate a distance. Drag the mouse to make a curve appear then 

right-click to create one. 

 

  
 

3. Select “No Line” on the “Line and Fill Shape” window on the object property window. 

 

               
 

4. Click  [Text Input] button then move the mouse cursor to the curve line. The cursor will change to text 

cursor as shown below. 

                 
 

5. When the cursor changes to text, click the curve line then enter the text. 

 

  

[Mouse drag] 
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Text Change 
The content of a text can be changed by using [Text Change] feature. 

Open a saved design sample, file or select the text objects entered on the work area. Click  [Text change] 

button or right-click with the mouse then select [Text Change] on the menu. Or, select [Menu] → [Text] → [Text 

change].  

 

 
 

Change the content in the “Text Change” window then click “OK” button. The modified text will be shown on the 

screen. 
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Template Creation 
 

Template is an image that corresponds to the material to be engraved by 1:1 ratio. Load a template similar to the 

shape of the material to be engraved then enter the text. This allows you to easily and conveniently position your 

text and determine its size. Templates such as circle, heart, square and diamond are available in the program, 

and users can freely add more templates. Templates can be created by using graphic programs like Illustrator, 

Photoshop and CorelDraw, or by loading images in SVG file format, jpeg, bmp, png, etc. 

 

[Creating template #1] 
1. Select [Menu] → [Template] → [Create Template from Image]. 

 

 
 

2. "Create Template from Image” window will appear.  
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3. Select the image file (jpeg, bmp, png and etc.) from the “Open” window then click “Open” button. 

 
 

4. Enter the size of the template. Check “Save” to save the image as a template for later use then enter the file 

name. Click “OK” button to load the image as a template. The image will be saved as a template in the template 

library. 
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[Creating template #2] 

1. Click  [Image] button to open an image file. 

 

     
 

2. Select [Menu] → [Template] → [Save Selected Object as Template].  

Enter a new template name in “Input” window then click “OK” button.  
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3. The saved template is added to the template library. 
 

 
 

The saved template in the “Save Selected Object as Template” menu is saved based on the size 

designated on the screen. When loading a template, check “Maintain Original Size” so the template will 

be loaded based on the original size designated when the template was saved. 
 

 
 

✽ Templates can be added or deleted. “Add” or “Delete” option can be selected by right-clicking in the template 

category window.  

  

[Mouse right button click] 
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Saving as Design Sample 
Edited texts, contents or designs can be saved as design samples for future use. 

 

[Saving as design sample #1] 
1. Edit contents and select the objects. 

 
 

2. Click File [Menu] → [Save as Design Sample] then select a folder or create new folder.  

Enter the name then click “Save.” 
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[Saving as design sample #2] 

1. Select the objects then click  [Design Sample] button. Select a folder from the design sample library 

window to save the created design. 

 
 

2. Click [Save selected image as sample] or right-click the design sample image then click “Save Selected 

as Design Sample” on the menu.  

 

 

   
  

[Mouse right button click] 
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3. Enter the name of the design created then click “OK” button. The design will be saved in the design sample 

library. 

 

 
 

          
 
✽ Right-click in the design sample window to see more features. The design sample can be deleted by  

right-clicking in the design sample window then select  or “Delete” on the menu. 

 

 

  

[Mouse right button click] 
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Auto Change of Serial Number 
 

Use this function when changing numbers by certain unit. 

 

1. Edit the font and size of text object with a number then press “Alt+N” key on a keyboard, or select [Menu] → 

[Text] → [Serial Number] → [Advance Serial Number] to change the number automatically. 

 

 
 

 
 

 

            
 

 

2. Select [Menu] → [Text] → [Serial Number] → [Serial Number Option] then enter a unit from the “Serial Number 

Auto Advancing Option” to change the serial number based on the assigned unit automatically. 
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3. If the serial number is not consistent, select [Menu] → [Text] → [Serial Number] → [Load Serial Number]. 

Enter serial number in the “Lines to export” field or click “Load File” button to load from a file (.txt or .csv file 

format). Once the serial numbers are loaded, click “Export to object” button. The text on the selected text object 

is automatically changed, and the serial number is deleted from the list. The deleted numbers will be shown in 

the “Exported Lines.” 
 

 
 

 
 

Serial numbers can be loaded from a file separated by a comma (.csv) or text file (.txt).  

Each row of the file is recognized as one serial number, and the contents of each row separated by a 

comma are shown in the next line. 
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Loading and Editing Image 
 

1. Loading an image 
This program provides a function to load various types of image files. Supported image files are as follows. 
 

BMP Windows or OS/2’s bitmap graphic file 

GIF CompuServe graphic file 

JPG/JPEG JPEG bitmap graphic file 

PNG Portable Network Graphics bitmap graphic file 

PCX Z Soft PC paintbrush bitmap file 

TIF/TIFF Tagged Image File Format bitmap file 

WMF Windows meta file 
 

 

Image file can be loaded through the following methods. 

 

1. Select  [Image] on the toolbar or select [Menu] → [Insert] → [Image]. 

 
 

2. When “Open” window appears (as shown in the picture below), select the image to load then click “Open” 

button. 
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3. Drag the work area with the mouse to load the image according to desired size. 

 
 

2. Converting and editing image 
 

The machine can only engrave single-color images; not multi-color images. Multi-color images should be 

converted to single-color (1 bit) image. 

 

[Converting to single-color image] 

 
1. Select the image you want to convert. Click “Convert” button in the image object window then select 

“Monochrome (1bit).” 

  
 

Or select the Transform menu → Bitmap → Mode → Monochrome (1bit). 

 
 

  

[Mouse drag] 
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2. When “Color Image to Black & White” window appears, move the slider to adjust the level of color then click 

“OK” button. 
 

 

 

[Editing image] 
Loaded image can be edited via “Paint” program in Windows.  

Select the image object to be edited then right-click to select “Edit” or, select [Menu] → [Transform] → [Bitmap] → 

[Edit].  

 
 

Click [OK] to run Windows Paint program. 

 
Then “Image Edit Notification” will appear. 

Once editing is completed, click “Save” from Paint File menu then close the program to apply the changes. 
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Import a File in SVG format 
MagicEngrave supports vector graphic files in SVG format. If a design is created in programs like Illustrator or 

CorelDraw, the design can be loaded as long as it is saved as SVG file. 

 

1. Select File menu → Save As from Illustrator program to save a file in SVG format. 

 
 

 

 

 

2. When SVG option window appears, click “OK” button to save changes.  
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3. Click  button to load the SVG file. 

 
 

4. Or select [Menu] → [File] → [Import…] to import a file. 

 

 
 

5. Once the file is imported, click the work area to display the image. 
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Calibration 
※ The machine is initially set up at the factory. Please contact your reseller first before making any 

changes to the settings of the machine. 

※ Only carbide and diamond tools can be calibrated. Do not calibrate tools such as endmill and 

cutter. 

※ Be sure to unlock the pressure lock when calibrating the machine. Nose, tool and material can be 

damaged if the head is fixed or when the pressure lock is locked. 
 

1. Touch Sensor (Tool Calibration) 
 
1. Place and secure the material on the clamp. 
 
2. When attaching the tool, keep the length short as possible. 
 

3. Press  (Flat) on operation button to move the tool to the clamp. 
 

4. Press  button to enter menu mode. 
 

5. Use buttons. When 3.Calibration menu appears on the LCD window, press and hold 

 button to run the menu. 
 

6. Select “1.Touch Sensor” then press and hold  button to run the menu. 
 
7. The tool will be lowered and come in contact with the material and will be placed in the center of the clamp. 
 
8. Lower the tool by loosening the fixing bolt of the tool with a wrench, or lift the material with your hand to make 
the tool and material come in contact as shown in the picture below. 
 

 
 

9. Long-press and hold  button (for more than 3 seconds) until it beeps to confirm that the setting is saved 
then the tool will measure the material’s height. 
 

2. Laser Pointer Calibration 
 
[Spindle] 
1. Place and secure a flat material on the clamp. 

2. Press  button to enter menu mode. 

3. Use  buttons. When 3.Calibration menu appears on the LCD window, press  
button to run the menu. 
 

4. Select the “3.Pointer/Flat” then press  button to run the menu. 
 

The tool comes in contact with the material 
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5. The tool draws a cross (＋) line on the material and the laser pointer is turned on. 
 

6. Move the laser pointer to the center of the cross by using the  direction keys then press 

 button. 
 

 
 
7. The laser pointer moves closer to the material to calibrate the laser pointer’s origin. Move the laser pointer to 

the center of the cross by using the   direction keys on the engraving machine then long-

press and hold the  button (for more than 3 seconds) until it beeps to confirm that the setting is saved. 
 

[Rotation clamp] 
1. Remove the installed clamp. To remove the installed clamp, turn the clamping knob to the left then pull out the 
clamp and spacer block. 

               
2. Secure the ring to the rotation clamp.  
(When setting the laser pointer origin, rings with 18mm width (Max.18mm(0.7in) can be used. Rings with 
width over 18mm (Over 18mm(0.7in) cannot be used. 

 
 

3. Press  button to move the tool to the clamp. 
 

4. Use  buttons. When 3.Calibration menu appears on the LCD window, then press  
button to run the menu. 
 

5. Select the “4.Pointer/Rotary” then press  button to run the menu. 
 
6. The tool draws a cross (+) on the material and the laser pointer is turned on. 
 

 

7. Use the  direction keys to move the laser pointer to the center of the cross then press 

button to save the settings. 
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8. The laser pointer moves closer to the material to calibrate the laser pointer’s origin. Move the laser pointer to 

the center of the cross by using the  direction keys on the engraving machine then press and 

hold the  button (for more than 3 seconds) until it beeps to confirm that the setting is saved. 
 

[L-Tool] 
1. Remove the installed clamp. To remove the installed clamp, turn the clamping knob to the left then pull out the 
clamp and spacer block. 

 
2. Secure the ring to the rotation clamp.  
(When setting the laser pointer origin, rings with 18mm width (Max.18mm(0.7in) can be used. Rings with 
width over 18mm (Over 18mm(0.7in) cannot be used. 

 
 

3. Press  button to enter menu mode. 
 

4. Press  button. When 3.Calibration menu appears on the LCD window, then press  
button to run the menu. 
 

5. Select the “5.Pointer/L-Tool” then press  button to run the menu. 
 
6. When a “Pull DOWN” message appears on the LCD window (as shown below), pull the L-Tool down to the 

engraving line 1 (RING1) then press button.  

 
 

 

7. The tool draws a cross (＋) line on the material. 
 

 
8. When “Push UP message appears on the LCD window (as shown below), push the L-Tool up then press the 

button. The laser pointer is turned on. 
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9. Move the laser pointer to the center of the cross by using the direction keys then press the 

 button to confirm that the setting is saved. 

 
 
 
10. The laser pointer moves closer to the material to calibrate the laser pointer’s origin. Move the laser pointer to 

the center of the cross by using the direction keys on the engraving machine then long-press 

and hold the  button (for more than 3 seconds) until it beeps to confirm that the setting is saved. 
 

 

3. Saving Multi-performance Clamp Origin Position 

1. Press one of the buttons  to switch to [Move mode-Flat]. 
 

2. When the LCD window displays the following (as shown below), press  [Laser pointer] button to turn on the 
laser pointer. 

 

               
 

3. Use the   direction keys to set the laser pointer origin. 
 

 
 

4. Press the  button to display save confirmation on the LCD window. 
- Short press button: Temporary save (message guide X) 
- Long-press and hold button (for more than 3 seconds): Permanent save  

          

               
 

5. Press the  button to save the setting.  
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4. Saving New Clamp Origin Position 
 

1. Press  button to enter menu mode. 
 

2. Use  buttons. When 2. Select Origin menu appears on the LCD window, press  
button to run the menu. 
 

3. When menu appears on the LCD window (as shown below), use  buttons to select “Clamp” and use 

 buttons to select “Origin.” 

            
 

4. Long-press and hold the  button (for more than 3 seconds) until it beeps to confirm that the setting is 
saved. 

5. Chuck Finger Origin point 
 
1. Attach the chuck finger to the rotary clamp. 

              
[Flat chuck finger]              [Round chuck finger] 

 

2. To enter the [Standby-Rotary] mode, press [Finger Mode] button. 

       

            
 

3. Press  button to switch to [Move mode-Rotary]. 

When the LCD window displays the following (as shown below), press  [Laser pointer] button to turn on the 
laser pointer. 
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4. Use the  direction keys to match the laser pointer to the base point of each chuck finger as 
shown below. 

            
[Flat chuck finger]              [Round chuck finger] 

 

5. Press the  button to display save confirmation on the LCD window. And press  button to change 
mode. (Flat finger → Round finger → cylinder). 
 

- Short press button: Temporary save (message guide X) 
- Long-press and hold button (for more than 3 seconds): Permanent save  

          

               
 

6. Press the  button to save the setting. 
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6. Rotation Clamp Origin point (Z axis) 
 

1. To enter the [Ring Inside] mode, press [Finger Mode] button. 

       

           
 
2. Set the sharp tool into the rotation chuck as shown below. 

    
 

3. Press  button to switch to [Move mode-Rotary]. 
 

4. When the LCD window displays the following (as shown below), press  button to change the [Z-axis 
mode]. 

          

               
 

5. Use  buttons to horizontally align the tip of the engraving tool to the tip of the blade (as shown 

below). Use   buttons to adjust the distance between tools. Be sure the tips are closer to each other. 

 
 

6. Press the  button to display save confirmation on the LCD window. 
- Short press button: Temporary save (message guide X) 
- Long-press and hold button (for more than 3 seconds): Permanent save  

          

               
 

7. Press the  button to save the setting. 



128 

7. Camera calibration 

Bakelite plate 

(120x100x2t) 
 

 
1. Camera can be calibrated in the MagicEngrave program. 

   
 

2. Use the  button to adjust the red line (that appears on the screen) to center of the clamp. Once the 
red line is adjusted to the center, click [Next]. 
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3. Place and secure the bakelite to the clamp. Set the calibration area to 90 x 70mm then click [Create Line]. 
Check the calibration results then click [OK]. 
 

  
  

4. Press and hold the  button (for more than 3 seconds) until it beeps to start engraving. A rectangle will be 
engraved for calibration.  
 
5. Align the red corner marks to the calibration line corners with the mouse or keyboard. 

    
< Actual camera view on program > 
 

 


